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While Deltek has attempted to verify that the information in this document is accurate and complete, 
some typographical or technical errors may exist. The recipient of this document is solely responsible for 
all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is subject to 
change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are reserved. No 
part of this document may be reproduced or transmitted in any form or by any means, electronic or 
mechanical, or translated into another language, without the prior written consent of Deltek, Inc. 

This edition published August 2018. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and proprietary 
information of Deltek, Inc. and its licensors. The Deltek software, and all related documentation, is 
provided for use only in accordance with the terms of the license agreement. Unauthorized reproduction 
or distribution of the program or any portion thereof could result in severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 
This document is a compilation of the release notes distributed for the enhancements made in Costpoint, 
Budgeting and Planning, and Time & Expense in August 2018. This document includes descriptions of the 
enhancements in relation with system jars, application jars, libraries, and regulatory updates since the last 
system jar release. 

 
 

Note: Release notes contain summaries of the enhancements made. Refer to the online help for 
additional details.  

          Costpoint 7.1.1 Online Help 

http://help.deltek.com/Product/Costpoint/7.1.1/GA/costpoint_help.htm
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Platform Changes  
Weblogic 12.1.3 and 12.2.1.3 Critical Patch Update  
The Costpoint 7.1.1 Framework installer is updated to include support and compatibility for Weblogic 
12.1.3 and Weblogic 12.2.1.3 Oracle Critical Patch Update (July 2018). The update aims to address 
security vulnerabilities.  

System Requirements  

This enhancement requires the following:  

 p27919943_121300_Generic.zip  

 p27912627_122130_Generic.zip  
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Installation Instructions 

Custom Programs Affected 
Sometimes an update can cause custom programs and reports to stop working as expected. Before 
applying this update, consider whether you have any custom programs or reports in the application area 
affected by the update. If so, contact Deltek Support Center at https://deltek.custhelp.com before you 
install the update. 

To Download the HotFix/Feature Update: 
1. From Internet Explorer, go to https://dsm.deltek.com. 

2. Click Run Deltek Software Manager. 

3. Log in using your Deltek Support Center credentials. 

4. In the left pane of the Deltek Software Manager, expand your Deltek product. 

5. Expand the Hot Fixes folder for your product, and select the update to download. 

6. Click Download at the bottom of the screen. 

To Install the HotFix/Feature Update: 
Refer to the installation instructions posted on Deltek's Support Center site, https://deltek.custhelp.com. 

 For Costpoint 7.1.1 updates, refer to Knowledge Base article 79232. 

 For Costpoint 7.0.1 updates, refer to Knowledge Base article 73769. 

 For Costpoint 7.0 updates, refer to Knowledge Base article 67722. 

Before you install this update, please review all previous updates in the Knowledge Base article. You may 
need to install prerequisite programs or database patches (described in the Knowledge Base article) prior 
to installing this update. Note that when you download an update using Deltek Software Manager (DSM), 
all dependent files are automatically downloaded. 

To Check to See if the HotFix is Installed: 
1. Open the application that was updated. 

2. Click Help > About Costpoint from the Costpoint toolbar. This will display a screen that shows 
you the latest update JAR for the application that is open, as well as the latest system JAR and all 
patches applied to the system. 

To Check to See if the Feature is Installed: 
1. Click Help > About Costpoint from the Costpoint toolbar. 

2. Open the Features subtask and click the Feature that was just installed. 

3. Open the Applications subtask. Check the list of applications and their corresponding application 
jars and see if they are correct and have been successfully deployed (highlighted in green). 

4. Open the Patches subtask. Check the list of patches and see if they are correct and have been 
successfully deployed (highlighted in green).  

https://deltek.custhelp.com/
https://deltek.custhelp.com/
https://dsm.deltek.com/
https://deltek.custhelp.com/
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Note: Most of the features installed have their corresponding patches, but not all. 

More Information: 
If you have any questions, please contact Deltek Support Center at https://deltek.custhelp.com 

https://deltek.custhelp.com/
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Costpoint 

Accounting 
There are no changes to the Accounting domain for this release. 

Contracts 

Patch 3511 
PATCH3511 has been released in preparation for the future enhancements for the Configure Contract 
Management Settings screen. 

Patch 3467 
PATCH3467 has been released in preparation for the future enhancements for the Configure Opportunity 
Settings screen and for an upcoming new screen in the Contracts domain. 

User Options for Project Modification Effective Date: Phase II  
Having accurate effective dates in project modifications is important since these dates determine which 
modifications will be used in determining the amount of funding or contract value to be used in enforcing 
revenue ceilings. With the system date as a default for effective dates of new modifications, which was 
the previous functionality, revenue ceilings can be released prematurely if you are entering a future 
project modification. Although the date that defaults can be edited, users may not notice that the date is 
incorrect and revenue ceilings could get released incorrectly. 

To use more accurate effective dates for modifications when computing revenue, Costpoint now provides 
you the option to default the system date for effective dates or to leave the effective date field blank so 
users would be required to complete it.  

Screen Updates  

Several applications have been modified for this enhancement and rolled out in two releases.  
In a previous release, changes to the following screens were included:  
 Configure Project Settings (PJMSETNG)  
 Manage Modifications (PJMMOD)  
 Manage Project User Flow (PJMBASIC)  
 Import Project Master Data (PJPPREP)  
 Set Up Company (SYPCOMP)  
 
In this Phase II release, other applications with the Effective Date field have been updated.  

Screens with the Effective Date Field  

The Effective Date field on these screens now considers the option selected in the Modifications 
Effective Date group box in Configure Project Settings:  
 Manage Contracts (CTMCNTR), on the Modifications tab  
 Manage Subcontracts (CTMSBCNTR), on the Modifications tab  
 Manage Alternate Project Revenue Profiles (PJMALTPJ), on the Modifications subtask  
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 Manage Project Revenue Calculation Value History (PJMALTHS), on the Modifications subtask 

 

System Requirements  

This enhancement requires the following files. 

 
 Costpoint 7.1.1 System JAR 044 (cp711_sys_044.zip)  

 PATCH3499  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

Contracts Contracts CTMCNTR Manage 
Contracts 

cp711_ctmcntr_008.zip 

Contracts Contracts CTMSBCNTR Manage 
Subcontracts 

cp711_ctmsbcntr_009.zip 

Projects Project Setup PJMALTHS Manage Project 
Revenue 
Calculation Value 
History 

cp711_pjmalths_003.zip 

Projects Project Setup PJMALTPJ Manage 
Alternate Project 
Revenue Profiles 

cp711_pjmaltpj_006.zip 

Contract Management Reporting: Opportunity 
Changes to the following applications have been rolled out in preparation for the future release of the new 
opportunity reporting screens in the Contracts domain:  

 Manage Opportunities — A new check box, Exclude from Reports, has been added to this 
screen to allow you to indicate which opportunity records should be excluded from reports in the 
Contracts domain. This is important when you need to generate reports and exclude certain types 

Note: If Default System Date is selected on the Configure Project Settings screen, check that the 
date that defaults is applicable to new project modifications to avoid revenue ceilings being released 
incorrectly.  

If User Must Enter Date is selected, make sure to enter a value in Effective Date before saving the 
record to avoid an error. 

Note: The updates made to the applications in this release depend on the new setting added to the 
Configure Project Settings screen. To enable the full functionality of these updates, you must install 
the following files, which were made available in a previous release. 
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of opportunities (for example, indefinite delivery/indefinite quantity and blanket purchase 
agreement opportunities) to avoid overstating the reports. 

This application has also been modified to update the new Opportunity Audit table, 
OPP_VALUE_AUDIT, which captures data from the Manage Opportunities screen as changes 
are made to certain fields. The values in the audit tables will be used within trending reports 
within Costpoint Enterprise Reporting.  

 Manage Opportunity Stages — The following columns are now available on this screen to help 
you filter and group opportunity stages for reporting purposes:  

 Grouped Stage Name — Enter the grouped stage name for reporting on opportunities.  

 Include in Current Pipeline — Select this check box to include the opportunity stage in the 
current pipeline.  

 Win / Loss — Select the option where the opportunity stage should be included in pipeline 
reports and analytics. Valid values are Win, Loss, and NA, with NA as the default value.  

System Requirements 

This enhancement requires the following:  

 PATCH3466 

 PATCH3478 

Application JAR Requirements 

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

Contracts Opportunities CTMOPP Manage 
Opportunities 

cp711_ctmopp_009.zip 

Contracts Contract 
Management 
Controls 

CTMSTAGE Manage 
Opportunity 
Stages 

cp711_ctmstage_003.zip 

FAR and DFARS Updates  
Enhancements have been made to the Manage DFARS Library screen to enable you to track other 
supplemental regulation clauses/provisions in addition to Federal Acquisition Regulation (FAR) and 
Defense Federal Acquisition Regulation Supplement (DFARS) clauses/provisions, and associate these 
clauses/provisions to contracts and subcontracts. Some subtasks on the Manage Contracts and Manage 
Subcontracts screens have also been updated with additional fields that can provide adequate 
information about the clauses/provisions that apply to contracts and subcontracts. This information can 
help you determine whether you have the correct version of the clause or provision. 
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Screen Updates 

Manage Supplemental Regulations Library (CTMDFAR) 

Previously named Manage DFARS Library, this screen is now labeled as Manage Supplemental 
Regulations Library to cover clauses from both DFARS and other agencies.  

A new column, Agency, is added to this screen, which you can use to enter the agency who issued the 
supplemental regulatory clause. The DFARS Clause Number column has also been renamed to Clause 
Number.  

Manage Contracts (CTMCNTR)  

The following fields are now available on the FAR Clauses/Provisions subtask:  

 Description from Contract — Enter the FAR clause/provision description from the contract.  

 Page No — Enter the page number where the FAR clause/provision is located within the 
contract.  

 Effective Date — Enter, or use calendar to select, the effective date of the FAR clause/provision.  

These are the changes to the Supplemental Regulations subtask:  

 Previously labeled as DFARS Clauses, this subtask is now named Supplemental Regulations to 
cover clauses from both DFARS and other agencies.  

 The following fields have been renamed:  

 From Copy DFARS Clauses from to Copy Supplemental Regulations from  

 From DFARS Clauses to Supplemental Regulations  

 From DFARS Clause Number to Clause Number  

 The new fields on this subtask include:  

 Agency — Enter, or use lookup to select, the agency who issued the supplemental 
regulatory clause. 

 Description from Contract — Enter the supplemental regulatory clause description from the 
contract.  

 Page No — Enter the page number where the supplemental regulatory clause is located 
within the contract. 

 Effective Date — Enter, or use calendar to select, the effective date of the supplemental 
regulatory clause. 

Manage Subcontracts (CTMSBCNTR)  

The following fields are now available on the FAR Clauses/Provisions subtask:  

 Send to PO — Select this check box if the FAR clause/provision should flow to the purchase 
order associated with the subcontract.  

 Description from Contract — Enter the FAR clause/provision description from the contract.  

 Page No — Enter the page number where the FAR clause/provision is located within the 
contract.  

 Effective Date — Enter, or use calendar to select, the effective date of the FAR clause/provision.  

These are the changes to the Supplemental Regulations subtask:  
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 Previously labeled as DFARS Clauses, this subtask is now named Supplemental Regulations to 
cover clauses from both DFARS and other agencies.  

 The following fields have been renamed:  

 From Copy DFARS Clauses from to Copy Supplemental Regulations from 

 From DFARS Clauses to Supplemental Regulations 

 From DFARS Clause Number to Clause Number 

 The new fields on this subtask include: 

 Send to PO — Select this check box if the regulatory clause should flow to the purchase 
order associated with the subcontract.  

 Agency — Enter, or use lookup to select, the agency who issued the supplemental 
regulatory clause.  

 Description from Contract — Enter the supplemental regulatory clause description from the 
contract.  

 Page No — Enter the page number where the supplemental regulatory clause is located 
within the contract.  

 Effective Date — Enter, or use calendar to select, the effective date of the supplemental 
regulatory clause.  

System Requirements  

This enhancement requires the following:  

 PATCH3466  

 PATCH3497  

 PATCH3499  

 PATCH3513 

Application JAR Requirements 

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

Contracts Contract 
Management 
Controls 

CTMDFAR Manage 
Supplemental 
Regulations 
Library 

cp711_ctmdfar_003.zip 

Contracts Contract 
Management 
Controls 

CTMAGENC Manage 
Agencies 

cp711_ctmagenc_002.zip 

Contracts Contracts CTMCNTR Manage 
Contracts 

cp711_ctmcntr_008.zip 
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Domain Module Application ID Application 
Name 

Application File 

Contracts Contracts CTMSBCNTR Manage 
Subcontracts 

cp711_ctmsbcntr_009.zip 

Viewing Additional Reports in the Contracts Domain 
Some changes have been made available on the following screens in preparation for future 
enhancements in the Contracts domain:  

 Configure Opportunity Settings  

 Addition of parameter settings so that Project Labor Summary Report and Project Non-
Labor Detail Report can be run from Manage Opportunities  

 Manage Opportunities  

 Addition of Project Labor Summary Report and Project Non-Labor Detail Report to the 
Print and Preview menu selections on the Projects Linked subtask  

 Change of subtask name from Opportunity Teammates to Opportunity 
Teammates/Competitors  

 Change of field name from Prime/Subcontractor to Teammate/Competitor, and addition of 
Competitor to the drop-down list  

 Manage Contracts  

 Addition of Project Labor Summary Report and Project Non-Labor Detail Report to the 
Print and Preview menu selections on the Projects Linked subtask  

 Manage Subcontracts  

 Addition of Project Labor Summary Report and Project Non-Labor Detail Report to the Print 
and Preview menu selections on the General tab  

Note: Although these changes are already available on the screens, they have no impact on the current 
functionality yet. A future version of Costpoint will be required for these fields to take effect. 

Projects 

User Options for Project Modification Effective Date: Phase I  
Having accurate effective dates in project modifications is important since these dates determine which 
modifications will be used in determining the amount of funding or contract value to be used in enforcing 
revenue ceilings. With the system date as a default for effective dates of new modifications, which was 
the previous functionality, revenue ceilings can be released prematurely if you are entering a future 
project modification. Although the date that defaults can be edited, users may not notice that the date is 
incorrect and revenue ceilings could get released incorrectly.  

To use more accurate effective dates for modifications when computing revenue, Costpoint now provides 
you the option to default the system date for effective dates or to leave the effective date field blank so 
users would be required to complete it. 

Screen Updates 

Several applications have been modified for this enhancement and will be rolled out in two releases.  
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In this Phase I release, the following applications have been updated.  

Configure Project Settings (PJMSETNG)  

The new Modifications Effective Date group box added to this screen contains the following fields:  

 Default System Date — Select this option to have Costpoint use the system date as a default for 
the effective date of new project modifications. The date that defaults can still be changed when 
you select this option.  

 User Must Enter Date — Select this option to require the user to enter the effective date when 
entering new project modifications. No date defaults when you select this option, and the user 
must enter a date before he/she can save the modification record.  

Manage Modifications (PJMMOD) and Manage Project User Flow (PJMBASIC)  

The Effective Date field on these screens now considers the option selected in the Modifications 
Effective Date group box in Configure Project Settings:  

 Manage Modifications (PJMMOD), in the Modifications group box  

 Manage Project User Flow (PJMBASIC), on the Modifications subtask 

 

Import Project Master Data (PJPPREP)  

This application has been updated to consider the option selected in the Modifications Effective Date 
group box in Configure Project Settings when importing project modifications. It uses the following logic:  

 If Default System Date is selected and there is no Effective Date value (EFFECT_DT column in 
the PROJ_MOD table) in the input file, the system date defaults into the modification effective 
date when project modifications are imported.  

 If Default System Date is selected and an Effective Date value has been entered in the input 
file, Costpoint uses the input file effective date when project modifications are imported. The 
system does not overwrite this date with the current date.  

 If User Must Enter Date is selected, the input file must have an Effective Date value before it 
can be imported. If Effective Date is left blank, an error will be indicated in the Import Project 
Information Error Report.  

Set Up Company (SYPCOMP)  

Set Up Company has been modified to include the selection made in the Modifications Effective Date 
group box in Configure Project Settings when copying settings from one company to another.  

System Requirements  

This enhancement requires the following:  

 Costpoint 7.1.1 System JAR 044 (cp711_sys_044.zip)  

 PATCH3499  

Note: If Default System Date is selected on the Configure Project Settings screen, check that the 
date that defaults is applicable to new project modifications to avoid revenue ceilings being released 
incorrectly.  

If User Must Enter Date is selected, make sure to enter a value in Effective Date before saving the 
record to avoid an error. 
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Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

Projects Project Setup PJMBASIC Manage Project 
User Flow 

cp711_pjmbasic_029.zip 

Projects Project Setup PJMMOD Manage 
Modifications 

cp711_pjmmod_004.zip 

Projects Project Setup PJMSETNG Configure Project 
Settings 

cp711_pjmsetng_011.zip 

Projects Project Setup PJPPREP Import Project 
Master Data 

cp711_pjpprep_023.zip 

Admin System 
Administration 

SYPCOMP Set Up Company cp711_sypcomp_022.zip 

 

Add Subcontract ID to Project Modifications  
Costpoint now gives you the ability to add subcontract IDs to project modifications so that you can see 
project modifications entered by finance on your subcontracts. Several updates have been made on the 
following screens for this enhancement.  

Screen Updates  

Manage Modifications (PJMMOD)  

Changes to the Subcontract ID field includes the following:  

 Previously named Subcontract, this field is now labeled Subcontract ID.  

 Previously under Identification, the Subcontract ID field along with the Subcontract Name field 
are now in the Modifications group box.  

 If you are licensed for Contract Management:  

 This field is enabled if the Subcontract Modification ID field is blank. You can enter or use 
lookup to select a subcontract ID from a subcontract record created in the Contracts domain. 
Once you enter a subcontract ID for the project modification and save the record, this project 
modification becomes visible for the subcontract ID on the Manage Subcontracts screen.  

 This field is disabled if the Subcontract Modification ID field is not blank, and you will not be 
able to enter or modify the subcontract ID.  

 

Note: The Subcontract Modification ID field is visible only if you are licensed for Contract 
Management. 
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 If you are not licensed for Contract Management, you can enter a subcontract ID in this field, but 
this will not be validated by the system.  

Several other updates have been made to this screen, as follows:  

 The Contract field is now labeled Contract ID and has also been moved, together with the 
Contract Name field, to the Modifications group box.  

 If a contract ID exists for the project entered on this screen, that contract ID defaults in the 
Contract ID field upon tabbing out of the Project field. Previously, the contract ID displays only 
after saving the record.  

 The Contract ID, Contract Name, Subcontract ID, and Subcontract Name fields are now 
visible whether or not you are licensed for Contract Management.  

 

Manage Project User Flow (PJMBASIC)  

The Modifications subtask of Manage Project User Flow now has the following fields:  

 Contract ID  

 Contract Name  

 Subcontract ID  

 Subcontract Name  

The Subcontract ID field on this subtask follows the same logic as the Subcontract ID field on the Manage 
Modifications screen:  

 If you are licensed for Contract Management:  

 This field is enabled if the Subcontract Modification ID field is blank. You can enter or use 
lookup to select a subcontract ID from a subcontract record created in the Contracts domain. 
Once you enter a subcontract ID for the project modification and save the record, this project 
modification becomes visible for the subcontract ID on the Manage Subcontracts screen.  

 This field is disabled if the Subcontract Modification ID field is not blank, and you will not be 
able to enter or modify the subcontract ID.  

 
 If you are not licensed for Contract Management, you can enter a subcontract ID in this field, but 

this will not be validated by the system.  

For the Contract ID, if a contract ID exists for the project entered in the Identification group box of this 
screen, that contract ID defaults in the Contract ID field on the Modifications subtask upon tabbing out of 
the Project field. Previously, the contract ID displays only after saving the record.  

Import Project Master Data (PJMMOD)  

A new column, SUBCNTR_ID, has been added to the PROJ_MOD table.  

If the user is licensed for Contract Management, the value that populates this column must exist in 
Manage Subcontracts (SUBCNTR_ID column in the SUBCNTR_MASTER table). When the subcontract 

Note: The Contract Modification ID and Subcontract Modification ID fields remain hidden if you are 
not licensed for Contract Management. 

Note: The Subcontract Modification ID field is visible only if you are licensed for Contract 
Management. 
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ID is imported from SUBCNTR_MASTER, the project modification linked to that subcontract ID becomes 
visible on the Manage Subcontracts screen but remains in PROJ_MOD.  

If the user is not licensed for Contract Management, the value in this column is not validated.  

System Requirements  

This enhancement requires the following:  

 Costpoint 7.1.1 System JAR 044 (cp711_sys_044.zip)  

 cp711_cmnlib_PJMODLIB_001.zip  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

Projects Project Setup PJMBASIC Manage Project 
User Flow 

cp711_pjmbasic_029.zip 

Projects Project Setup PJMMOD Manage 
Modifications 

cp711_pjmmod_004.zip 

Projects Project Setup PJPPREP Import Project 
Master Data 

cp711_pjpprep_023.zip 

PJGOVTLIB and PJMODLIB Libraries  
The PJGOVTLIB library contains common business logic, which is shared by the following applications:  

 Manage Government Contract Information (PJMGOVT)  

 Manage Project User Flow (PJMBASIC)  

The PJMODLIB library contains common business logic, which is shared by the following applications:  

 Manage Alternate Projects (PJMALTRP)  

 Manage Contracts (CTMCNTR)  

 Manage Modifications (PJMMOD)  

 Manage Project User Flow (PJMBASIC)  

 Manage Subcontracts (CTMSBCNTR)  

System Requirements  

This enhancement requires the following:  

 Costpoint 7.1.1 System JAR 044 (cp711_sys_044.zip)  

 cp711_cmnlib_PJGOVTLIB_001.zip  

 cp711_cmnlib_PJMODLIB_001.zip  
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Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

Projects Project Setup PJMGOVT Manage 
Government 
Contract 
Information 

cp711_pjmgovt_003.zip 

Include Variance Amounts in the Statement of Indirect Expenses  
A new Variance column has been added to the Statement of Indirect Expenses (SIE) so you can know 
the difference between actual and budgeted amounts and determine where you are missing budgeted 
numbers that could account for a higher than expected indirect rate. Variance amount is calculated as 
Budget amount – Actual amount.  

To display this column, you must select the new Show Variance Column check box on the 
Compute/Print Pool Rates screen and select from the following options:  

 Current Period — Select this option to display variance amounts in the current period. When you 
select this option, the Variance column is displayed under Current Period on the SIE, together 
with the Actual and Budget columns.  

 Year To Date — Select this option to display year-to-date variance amounts. When you select 
this option, the Variance column is displayed under Year To Date on the SIE, together with the 
Actual and Budget columns.  

 

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

Projects Cost and 
Revenue 
Processing 

PJPCOMPP Compute/Print 
Pool Rates 

cp711_pjpcompp_007.zip 

People 

Costpoint Team Management Phase II  
This Costpoint Team Management module enhancement moves the Team Management setting from the 
Configure Personnel Settings screen to a new application, Configure Team Management Settings. The 

Note: The Year To Date Budget column is hidden when you select Current Period, and the Current 
Period Budget column is hidden when you select Year To Date. 
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Team Management settings allow you to specify if managers will be able to view the records of direct 
reports only, or of both direct and indirect reports, in Team Management applications. All applications in 
Team Management will reference the setting in the Configure Team Management Settings screen.  

 

Screen Updates  

Address (HTMADDRESS)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

Citizenship (HTMCITIZENSHIP)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

Company Property (HTMPROPERTY)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

Configure Team Management Settings (HTMSETTINGS)  

The Configure Team Management Settings screen will allow you to set up different options in the Team 
Management module. You will now use this screen to specify if managers can only view data for just their 
direct reports or if they can view data for both direct and indirect reports.  

Change Options Subtask 

Warning: The settings in the Change Options subtask of the Configure Team Management Settings 
screen are not yet available in this release (Phase II). This subtask will be fully functional in the Phase III 
release of Team Management enhancements. 

The Configure Team Management Settings screen contains a Change Options subtask that provides the 
following additional options for the Company Property, Phone/Email, Emergency Contacts, and Address 
applications:  

 Require HR Approval for Changes — This check box allows you to specify if HR approval is 
required for any change requests or changes made to an employee record by a manager 
(change/add/delete). If approval is required, any change requests generated from that application 
will be saved to a holding table instead of being inserted into the actual Employee table. If HR 
approval is not required, no change request will be created, the change will instead be saved 
directly to the appropriate Employee table.  

 Email HR Manager upon Change — This check box allows you to generate email notifications 
to an HR manager if a change occurred in an application. Companies that use Costpoint 
Personnel module can either select to email the appropriate HR manager for the employee or use 

Note: This Costpoint release only includes the functionality to specify if managers can view 
direct/indirect reports in Team Management applications. The additional features mentioned in the 
updates for Configure Team Management Settings screen will be available in the Phase III release of 
Team Management enhancements. 
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a default email address. Companies that do not use Costpoint Personnel module will only have 
the default option available to them.  

 HR Email Method — This field allows you to specify how HR Administrators will be notified by 
email. This field is only available if you select the Email HR Manager upon Change check box.  

 Default HR Email Address — This field allows you to specify a default email address for the HR 
representative. This email address will be sent an email if a manager makes a change to an 
employee record. This field is only available if you select Default Email in the HR Email Method 
drop-down list.  

 Email Manager upon Approval/Rejection — This setting sends an email the manager who 
initiated the change request when the HR manager either approves or rejects the change 
request. Currently all email messages in the notifications (both HR manager and change request 
manager) are generic system messages. In the future, we may want to consider allowing users to 
customize those messages in the configuration application.  

 Warning: The settings in the Change Options subtask of the Configure Team Management 
Settings screen are not yet available in this release (Phase II). This subtask will be fully functional 
in the Phase III release of Team Management enhancements. 

Configure Personnel Settings (HPMSET)  

The Team Management setting, which allows you to specify if managers can view direct reports only, or 
both direct and indirect reports, is no longer available on this screen. The setting moved to the new 
Configure Team Management Settings screen which contains settings specifically for Team Management 
module.  

The screen also contains the following changes:  

 The Managers, Accident Claims, and Required Forms Upload group boxes were removed.  

 The following options will longer be available in a group box:  

 Manager Defaulting Method  

 Accident Claim Numbering Method  

 Required Forms File Type  

 The Required Forms File Type label replaces the Required Forms Update group box.  

 The Training group box and Default Job Title Validation Method options were removed.  

 The By Company-Wide Organization option label was corrected.  

 The option label changed from “Claim Numbering Method” to “Accident Claim Numbering 
Method.”  

 The check box title changed from “Require Org ID” to “Require Organization ID (Talent 
Management).”  

Emergency Contacts (HTMEMERGENCYCONTACT)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  
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Government Documents (HTMGOVDOCUMENTS)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

Knowledge (HTMKNOWLEDGE)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports; or direct and 
indirect reports.  

Leave (HTMLEAVE)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

Life Events (HTMLIFEEVENTS)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

Phone/Email (HTMPHONE)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

Set Up Company (SYPCOMP)  

The new field from Configure Team Management Settings screen, Team Management view reports 
method, was added into company defaults.  

Team Details (HTMDETAIL)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports. 

Team Information Report (HTRTEAMINFO)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

Total Compensation and Benefits (HTMTOTALCOMP)  

The application now references the setting from the new Configure Team Management Settings screen 
which defines the Team Management method for displaying either only direct reports, or both direct and 
indirect reports.  

System Requirements  

This enhancement requires the following:  

 Costpoint 7.1.1 System JAR 044  
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 PATCH3484  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

People Team 
Management 

HTMADDRESS Address cp711_htmaddress_002.zip 

People Team 
Management 

HTMCITIZENSHIP Citizenship cp711_htmcitizenship_002.zip 

People Team 
Management 

HTMPROPERTY Company 
Property 

cp711_htmproperty_002.zip 

People Team 
Management 

HTMSETTINGS Configure 
Team 
Management 
Settings 

cp711_htmsettings_001.zip 

People Team 
Management 

HPMSET Configure 
Personnel 
Settings 

cp711_hpmset_004.zip 

People Team 
Management 

HTMEMERGENCYCONTACT Emergency 
Contacts 

cp711_htmemergencycontact_002.zip 

People Team 
Management 

HTMGOVDOCUMENTS Government 
Documents 

cp711_htmgovdocuments_002.zip 

People Team 
Management 

HTMKNOWLEDGE Knowledge cp711_htmknowledge_002.zip 

People Team 
Management 

HTMLEAVE Leave cp711_htmleave_002.zip 

People Team 
Management 

HTMLIFEEVENTS Life Events cp711_htmlifeevents_002.zip 

People Team 
Management 

HTMPHONE Phone/Email cp711_htmphone_002.zip 

People Team 
Management 

SYPCOMP Set Up 
Company 

cp711_sypcomp_022.zip 

People Team 
Management 

HTMDETAIL Team Details cp711_htmdetail_002.zip 
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Domain Module Application ID Application 
Name 

Application File 

People Team 
Management 

HTMTEAMINFO Team 
Information 
Report 

cp711_htmteaminfo_002.zip 

People Team 
Management 

HTMTOTALCOMP Total 
Compensation 
and Benefits 

cp711_htmtotalcomp_002.zip 

Use Format 3 for Employee History File Exports to Deltek Time and 
Expense 10+  
This Costpoint release updates the Export Data to Deltek Time and Expense (LDPDTC) screen to use 
version 3 format when exporting Employee History information to Deltek Time & Expense version 10.x+ 
or greater.  

Prior to this release, when exporting Employee History data, the application used the version 2 format for 
employee records, and the version 3 format for subcontractor records. With this enhancement, the 
application will use the version 3 format for both employee and subcontractor records in the Employee 
History file.  

 
When generating the Employee History file, the Export Data to Deltek Time and Expense screen 
performs the following if the login company uses Time & Expense 10.x+ (or greater) as the Deltek Time 
and Expense version in the Corporate Labor Settings subtask of the Configure Labor Settings screen: 

 Populate Field 1 (Format Version) of the employee EMPL_HISTORY records with “3”  

 Populate the following fields of the employee EMPL_HISTORY records with a NULL value:  

 Field 25 (Default UDT11)  

 Field 26 (Default UDT12)  

 Field 27 (Default UDT13)  

 Field 28 (Default UDT14)  

 Field 29 (Default UDT15)  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Note: Deltek Time and Expense can process an Employee History file with employee records that 
use the version 2 format and subcontractor records that use the version 3 format. However, if you 
export both employee and subcontractor records to Deltek Time and Expense, Deltek recommends 
that you apply this enhancement so that the same format will be used for both types of records. 
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Domain Module Application ID Application 
Name 

Application File 

People Payroll LDPDTC Export Data to 
Deltek and 
Expense 

cp711_ldpdtc_019.zip 

Regulatory and Compliance 

IMPORTANT NOTES 
Warning: Unless specifically noted in the release notes, any future federal and state tax table changes 
(not just Colorado) will require the following: 

System JAR 054 for Costpoint version 7.0.1 

System JAR 028 for Costpoint version 7.1.1 

Versions 7.0.1 and 7.1.1 - Calendar Year End 2018  

In an effort to allow adequate time to prepare for future year-end system jar requirements, please be 
aware that you must have the following System JARs loaded before the Calendar Year End 2018 release 
which is scheduled for December 2018. Appropriate action should be taken throughout the next months 
to plan for this System JAR requirement. 

Anticipated Calendar Year End 2018 System JAR Requirements  

 Costpoint 7.0.1: System JAR 054 (to be released June 2018)  

 Costpoint 7.1.1: System JAR 028 (released April 2017)  

 

Version 7.1.1 – Further Reductions in the Need to Release Regulatory Updates within System JARs  

We are happy to announce that we have made several programming changes within the past year to limit 
the need for regulatory changes to be released via System JAR. System JAR 028 for Costpoint 7.1.1 was 
part of that effort. The coding changes introduced in System JAR 028 for Costpoint 7.1.1 allowed us to 
disassociate payroll computation coding changes from future 7.1.1 System JAR releases. So, after 
System JAR 028, changes to Costpoint version 7.1.1’s Compute Payroll application will not require 

Notes: 

System JAR 054 for Costpoint 7.0.1 introduced an update to the Colorado state tax withholding 
tables. In response to the federal tax code overhaul (Pub. L. 115-97), the Colorado Department of 
Revenue announced an update to their Allowance table on April 2, 2018 (effective April 1, 2018). This 
required an update to Costpoint Compute Payroll, which can only be released through a System JAR 
in Costpoint version 7.0.1.  

System JAR 049 for Costpoint 7.0.1 and System JAR 028 for Costpoint 7.1.1 introduced a much 
needed change to the State Filing Statuses in Costpoint. Rather than using filing statuses that only 
applied to Costpoint (Both, Miscellaneous 1, Miscellaneous 2, etc.) and had to be manually mapped 
to each state’s actual filing statuses, Costpoint 7.0.1 and 7.1.1 have been updated to use each state’s 
actual filing status(es). Though the new filing statuses were introduced in April 2017, Deltek will 
continue to support tax table updates based on the original state filing statuses for the remaining 
2018 tax updates. Any tax updates for 2019 will only support the new state filing statuses that were 
introduced in System JAR 049 for 7.0.1 and System JAR 028 for 7.1.1 (both released in April 2017). 
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deployment via System JAR as they did in the past. This means that we can deploy Costpoint 7.1.1 
regulatory updates and fixes more quickly, and help us keep the System JAR requirements for Calendar 
Year End releases as minimal as possible. 

The changes we made with the noted System JARs will greatly help with that effort to minimize the 
System JAR requirements for future regulatory releases. 

2018 Oregon W-2 Electronic Filing 
The new statewide transit tax for the State of Oregon, which took effect on July 1, 2018, must be reported 
in the RS and RV records of the State’s W-2 file. In order to track the new tax, this release adds a new 
Transit Tax option to the Tax Type drop-down list on the Manage Local Taxes screen.  

When you set up the statewide transit tax for Oregon (State is Oregon and Tax Type is Transit Tax), 
then the local taxable wages and local tax withheld will be reported as the state taxable wages for 
statewide transit tax and statewide transit tax withheld, respectively, in the following records of Oregon's 
W-2 file:  

RS Record  

 Positions 348-358: Taxable wages for the statewide transit tax. Deductions that can be applied 
to wages for income tax withholding generally cannot be applied to wages subject to the transit 
tax.  

 Positions 359-369: Amount withheld for the statewide transit tax.  

RV Record  

 Positions 40-54: Total amount of taxable wages for the transit tax.  

 Positions 55-69: Total amount of statewide transit tax withheld.  

Warning: This Costpoint release only updates the Manage Local Taxes screen to allow you to track the 
new state transit tax. The updated Create State W-2 File screen which will include the new state transit 
tax in Oregon’s W-2 file will be released separately. 

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

People Payroll PRMLTI Manage Local 
Taxes 

cp711_prmlti_008.zip 

2018 New Jersey Withholding Tax  
The State of New Jersey issued updated withholding tables, effective September 1, 2018, which 
implements a new withholding rate of 15.6 percent for incomes of at least $5 million regardless of the 
taxpayer’s filing status. This release adds new records for New Jersey in the following screens so that the 
taxes of this State will be calculated accurately in Costpoint Payroll:  

 Manage State Tax Withholding Adjustments  

 Manage State Standard Deductions  
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 Manage State Tax Tables  

System Requirements  

This enhancement requires Costpoint 7.1.1 PATCH3505. 

2018 Maryland Withholding Tax  
The State of Maryland released a revised withholding guide which reflects changes to the state's standard 
deduction for the 2018 tax year. Maryland’s maximum standard deduction increases from $2,000 to 
$2,250.  

Costpoint will be using the new maximum standard deduction amount for Maryland payroll. In order to 
accomplish this, this Costpoint release adds new records, effective July 1, 2018, for Maryland in the 
Manage State Standard Deductions and Manage Local Standard Deductions screens.  

 

System Requirements  

This enhancement requires Costpoint 7.1.1 PATCH3518. 

Materials Management 

Organizational Security – Sales Order Entry 
The Organizational Security feature enhances the secure functionality of Costpoint by warranting proper 
user access throughout the Materials domain, specifically in the Sales Order Entry module. This feature 
ensures that correct user access is applied to the logged-in user ID in accessing inventory transactions by 
validating and filtering records/transactions as authorized for the user ID. 

Patch and System JAR Requirements 

These enhancements require the following: 

 Costpoint 7.1.1 System JAR 044 (cp711_sys_044.zip) 

 PATCH3489 

 PATCH5122 

Application JAR Requirements 

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application Name Application 
ID 

Application Files 

Materials OE Manage Sales Order 
Entry 

OEMNTSO1 cp711_oemntso1_003.zip 

Attention: For more information, please refer to the Maryland Employer Withholding Guide: 
http://forms.marylandtaxes.gov/current_forms/Withholding_Guide.pdf. 

http://forms.marylandtaxes.gov/current_forms/Withholding_Guide.pdf
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Domain Module Application Name Application 
ID 

Application Files 

Materials OE Manage Sales Order 
Supervisor Screen 

OEMNTSO2 cp711_oemntso2_003.zip 

Materials OE Approve Sales Order OEMAPPSO cp711_oemappso_010.zip 

Materials OE Print Sales Order 
Acknowledgements 

OERACKN cp711_oerackn_006.zip 

Materials OE Manage Sales Order 
User-Defined 
Information 

OEMSOUDI cp711_oemsoudi_003.zip 

Materials OE Create Purchase 
Requisitions from 
Sales Orders 

OEPGRQ cp711_oepgrq_011.zip 

Materials OE Print Sales Order 
Pick List 

OERPICK cp711_oerpick_006.zip 

Materials OE Manage Sales Order 
Inventory Issues 

OEMISSU1 cp711_oemissu1_002.zip 

Materials OE Manage Sales Order 
Non-Inventory Issues 

OEMISSU2 cp711_oemissu2_002.zip 

Materials OE Manage Shipping 
Transactions 

OEMSHIP cp711_oemship_014.zip 

Materials OE Print Packing Slips OERPCKSL cp711_oerpcksl_007.zip 

Materials OE Print DD250 Packing 
Slips 

OER250PS cp711_oer250ps_006.zip 

Materials OE Print WA250 Packing 
Slips 

OERW250P cp711_oerw250p_002.zip 

Materials OE Print Sales Order 
Approval Status 
Report 

OERAPPR cp711_oerappr_003.zip 

Materials OE Print Sales Order 
Backlog Report 

OERBLOG cp711_oerblog_003.zip 

Materials OE View Sales Analysis 
Information 

OEQSALES cp711_oeqsales_008.zip 

Materials OE Create RFID Print 
File 

OEPRFID cp711_oeprfid_003.zip 
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Domain Module Application Name Application 
ID 

Application Files 

Materials OE View Sales Order 
Status Information 

OEQSTAT cp711_oeqstat_009.zip 

Materials OE Import Sales Order AOPSOPP cp711_aopsopp_012.zip 

Materials OE Load Organization 
IDs 

OEPLDORG cp711_oepldorg_001.zip 

Materials IN Load Organization 
IDs 

INPLDORG cp711_inpldorg_002.zip 

Materials IN Create Inventory 
Allocations 

INPALLOC cp711_inpalloc_005.zip 

Administration Domain 

This section includes summaries of the changes made in relation with the Organization Security feature 
within the Costpoint Administration domain. 

View Help About (SYMABOUT)  

The Features subtask on the View Help About (SYMABOUT) screen now includes the Organization 
Security feature for the Sales Order Entry module. 

Materials Domain 

This section includes summaries of changes made in relation with the Organization Security feature 
within the Costpoint Materials domain. 

Manage Sales Orders (OEMNTSO1)  

The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s 
authorization of the organization ID (new). In addition, Costpoint will not display sales orders 
where organization are left blank. 

 Lookup 

 Project — Costpoint now narrows the search and displays only projects with owning 
organizations authorized for the logged-in user ID. 

 Organization — Costpoint now narrows the search and displays only organizations 
authorized for the logged-in user ID. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations 
(standard material) with organizations, and project (owning organization) authorized for the 
logged-in user ID. 

 Document — Costpoint now narrows the search and displays only documents that are linked 
to organizations authorized for the logged-in user ID. Costpoint also displays documents that 
are not linked to any organization. 
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 A new field, Organization, has been to the screen. Use this field to enter an organization ID for 
the sales order. This field is required if the Organization Security feature is enabled. 

 Costpoint now validates your selected/entered entries in several fields against your logged-in 
user ID’s organization and project’s owning organization rights. 

 Approval Process (when approval process is enabled and you submit sales orders (SO) for 
approval) — IF you add an approval process/approval title, at least one of the users for each 
approval title(s) must be authorized for the organization ID. 

 If none of the users for any of the approval titles in the approval process is authorized for the 
organization ID (new), Costpoint displays an error message. 

 If at least one of the users for the approval titles in the approval process is authorized for the 
organization ID (new), Costpoint displays a warning message. 

Manage Sales Order Supervisor Screen (OEMNTSO2)  

The following are the changes to this screen: 

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s 
authorization for the organization ID (new). In addition, Costpoint will not display sales orders 
where organizations are left blank. 

 Lookup 

 Project — Costpoint now narrows the search and displays only projects with owning 
organizations authorized for the logged-in user ID 

 Organization — Costpoint now narrows the search and displays only organizations 
authorized for the logged-in user ID. 

 Inv Abbrev — Costpoint now narrows the search and displays only inventory abbreviations 
(standard material) with organizations, and projects (owning organization) authorized for the 
logged-in user ID. 

 Document — Costpoint now narrows the search and displays only documents that are linked 
to organizations authorized for the logged-in user ID. Costpoint also displays documents that 
are not linked to any organization.  

 A new field, Organization, has been added to the screen. Use this field to enter an organization 
ID for the sales order. This field is required if the Organization Security feature is enabled.  

 Costpoint now validates your selected/entered entries in several fields against your logged-in 
user ID's organization and project’s owning organization rights.  

 Approval Process (when approval process is enabled and you submit sales orders for approval) 
— If you add an approval process/approval title, at least one of the users for each approval title(s) 
must be authorized for the organization ID.  

 If none of the users for any of the approval titles in the approval process is authorized for the 
organization ID (new), Costpoint displays an error message.  

 If at least one of the users for the approval titles in the approval process is authorized for the 
organization ID (new), Costpoint displays a warning message.  

Approve Sales Orders (OEMAPPSO)  

The following are the changes to this screen: 
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 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s 
authorization for the new organization ID. In addition, Costpoint will not display sales orders 
where organizations are left blank.  

 Costpoint now validates your selected/entered entry against your logged-in user ID's organization 
rights.  

 Approval Process (when approval process is enabled and you submit sales orders for approval) 
— If you add an approval process/approval title, at least one of the users for each approval title(s) 
must be authorized for the organization ID.  

 If none of the users for any of the approval titles in the approval process is authorized for the 
organization ID (new), Costpoint displays an error message.  

 If at least one of the users for the approval titles in the approval process is authorized for the 
organization ID (new), Costpoint displays a warning message.  

Print Sales Order Acknowledgments (OERACKN)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entry against your logged-in user ID's organization 
rights.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations that are authorized for the logged-in user ID. In addition, Costpoint will not 
display sales orders where organizations are left blank.  

 When you click Print/Preview, Costpoint displays all records where you have full rights to the 
organization.  

 When you select Flag SO Acknowledgment as Printed, Costpoint only updates record flags 
where you have full rights to the organization. 

 Logic has been added to the application to suppress all line details in the report if your logged-in 
user ID does not have full rights to the sales order organization, and the following message is 
printed: “Sales Acknowledgment not printed. Your user ID is not authorized for the Organization 
on this Sales Order.”  

Manage Sales Order User-Defined Information (OEMSOUDI)  

Costpoint now finds and filters existing sales order records based on your logged-in user ID’s 
organization rights for the new organization ID. In addition, Costpoint will not display sales orders where 
organizations are left blank. 

Create Purchase Requisitions from Sales Orders (OEPGRQ)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entries against your logged-in user ID's 
organization and requisitioner’s organization rights.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales 
orders where organizations are left blank.  

 When you click Execute, Costpoint will only display and process records where you have full 
rights to the organization.  
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 Approval Process — If organization security is enabled in the system settings, and the screen is 
activated for organization security, Costpoint will not allow you to enter or select an SO if your 
user ID is not authorized for the requisitioner’s organization linked to the SO.  

 If none of the users for any of the approval titles in the approval process is authorized for the 
requisitioner’s organization, Costpoint generates the requisition but the approval process 
code is left blank, and status is set to Pending.  

 If at least one of the users for the approval titles in the approval process is authorized for the 
requisition organization, Costpoint generates requisitions with Approval and In-Approval 
status.  

 When your logged-in user ID is not authorized for the organization linked to the SO which you 
created a requisition for, Costpoint prints a report with the following error message: “Requisition 
not created. Your user ID is not authorized for the Organization linked to this Sales Order.”  

Print Sales Order Pick List (OERPICK)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entry against your logged-in user ID's organization 
rights.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations that are authorized for the logged-in user ID. In addition, Costpoint will not 
display sales orders where organizations are left blank.  

 When you click Print/Preview, Costpoint displays all records where you have full rights to the 
organization.  

 When you select the Update Sales Order Pick List printed flag, Costpoint only updates and 
processes records where you have full rights to the organization. 

 When you click an SO and the SO selected is linked to an organization not authorized for your 
logged-in user ID, Costpoint displays an error message.  

 Logic has been added to the application to suppress all line details in the report if your logged-in 
user ID does not have full rights to the organization linked to the SO, and the following message 
is printed: “SO information not printed. Your user ID is not authorized for the Organization on this 
Sales Order.”  

Manage Sales Order Inventory Issues (OEMISSU1)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entries against your logged-in user ID's 
organization and project owning organization rights.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales 
orders where organizations are left blank.  

 A new field, Organization, has been added to the screen to display the organization ID for the 
sales order.  

 Costpoint now saves the organization linked to the sales order in the inventory transaction table.  

Manage Sales Order Non-Inventory Issues (OEMISSU2)  

The following are the changes to this screen:  
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 Costpoint now validates your selected/entered entries against your logged-in user ID's 
organization rights.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales 
orders where organizations are left blank.  

 A new field, Organization, has been added to the screen to display the organization ID for the 
sales order.  

 Costpoint now saves the organization linked to the sales order in the inventory transaction table.  

Manage Shipping Transactions (OEMSHIP)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entries against your logged-in user ID's 
organization rights.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales 
orders where organizations are left blank.  

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s 
authorization for the organization linked to the SO associated with the shipping transactions. If 
this organization ID in the header section is blank, Costpoint will not display the record.  

 A new field, Organization, has been added to the screen to display the organization ID for the 
sales order. 

Print Packing Slips (OERPCKSL)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entries against your logged-in user ID's 
organization rights.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations authorized for the logged-in user ID. In addition, Costpoint will not display sales 
orders where organizations are left blank.  

 When you click Print/Preview, Costpoint displays all records where you have full rights to the 
sales order’s organization.  

 When you select Flag Packing Slip as Printed, Costpoint only updates and processes records 
where you have full rights to the sales order’s organization.  

 Logic has been added to the application to suppress all line details in the report if your logged-in 
user ID does not have full rights to the organization linked to the SO, and the following message 
is printed: “SO information not printed. Your user ID is not authorized for the Organization linked 
to this sales order.”  

Print DD250 Packing Slips (OER250PS)  

The following are the changes to this screen:  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations that are authorized for the logged-in user ID. In addition, Costpoint will not 
display sales orders where organizations are left blank.  

 Costpoint now validates your selected/entered entries against your logged-in user ID's 
organization rights.  
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 When you click Print/Preview, Costpoint displays packing slips where you have full rights to the 
sales orders’ organization.  

 When you select Flag DD250/WA250 Packing Slips as Printed, Costpoint only updates the flag 
of the packing slips where you have full rights to the sales orders’ organization.  

 Logic has been added to the application to suppress all line details in the report if your logged-in 
user ID does not have full rights to the organization associated with the SO in the packing slip, 
and the following message is printed: “Packing Sip information not printed. User is not authorized 
for the organization linked to the sales order.”  

Print WA250 Packing Slips (OERW250P)  

The following are the changes to this screen:  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only sales orders linked 
to organizations that are authorized for the logged-in user ID. In addition, Costpoint will not 
display sales orders where organizations are left blank.  

 Costpoint now validates your selected/entered entries against your logged-in user ID's 
organization and sales order’s organization rights.  

 When you click Print/Preview, Costpoint displays packing slips where you have full rights to the 
sales orders’ organization.  

 When you select Update DD250/WA250 Printed Flag, Costpoint only updates the flag of the 
packing slips where you have full rights to the sales orders’ organization. 

 Logic has been added to the application to suppress all line details in the report if your logged-in 
user ID does not have full rights to the organization associated with the SO in the packing slip, 
and the following message is printed: “Packing Slip information not printed. User is not authorized 
for the organization linked to the sales order.”  

Print Sales Order Approval Status Report (OERAPPR)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entry against your logged-in user ID's organization 
rights for the SO.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with 
organizations that are authorized for the logged-in user ID.  

 When you click Print/Preview, Costpoint displays records where you have full rights to the SO 
organization. In addition, Costpoint will not display sales orders where organizations are left 
blank.  

Print Sales Order Backlog Report (OERBLOG)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entry against your logged-in user ID's organization 
rights for the SO.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with 
organizations that are authorized for the logged-in user ID.  

 When you click Print/Preview, Costpoint displays records where you have full rights to the SO 
organization. In addition, Costpoint will not display sales orders where organizations are left 
blank.  
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View Sales Analysis Information (OEQSALES)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entry against your logged-in user ID's organization 
rights for the SO.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with 
organizations that are authorized for the logged-in user ID. In addition, Costpoint will not display 
sales orders where organizations are left blank.  

 When you click Execute, Costpoint displays records where you have full rights to the SO 
organization. In addition, Costpoint will not display sales orders where organizations are left 
blank.  

Create RFID Print File (OEPRFID)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entry against your logged-in user ID's organization 
rights for the SO.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with 
organizations that are authorized for the logged-in user ID. In addition, Costpoint will not display 
sales orders where organizations are left blank. 

 When you select Create RFID Print File, Costpoint displays records where you have full rights to 
the SO organization. In addition, Costpoint will not display sales orders where organizations are 
left blank.  

View Sales Order Status Information (OEQSTAT)  

The following are the changes to this screen:  

 Costpoint now validates your selected/entered entry against your logged-in user ID's organization 
rights for the SO.  

 Lookup (Sales Order) — Costpoint now narrows the search and displays only SOs with 
organizations that are authorized for the logged-in user ID. In addition, Costpoint will not display 
sales orders where organizations are left blank.  

 When you click Execute, Costpoint displays records where you have full rights to the SO 
organization. In addition, Costpoint will not display sales orders where organizations are left 
blank.  

Import Sales Orders (AOPSOPP)  

The logic of this application has been changed to load/populate the new Organization field on the Manage 
Sales Orders screen.  

Load Organization IDs (OEPLDORG)  

Use this new screen (Materials » Sales Order Entry » Sales Order Entry Utilities » Load 
Organization IDs) to load or default a value to the new field, Organization, for sales orders.  

 

Note: You must run this utility before turning on organization security for a module. If you skip this 
process, query results will exclude sales orders with blank organization IDs.  
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Load Organization IDs (INPLDORG)  

Use this new screen (Materials » Inventory » Inventory Utilities » Load Organization IDs) to load or 
default material handler’s organizations for miscellaneous receipts and location transfer IDs. This utility 
automatically runs in the backend to populate the inventory transaction table for the other inventory 
transaction types such as Issue to Purchase Order (ISSUEPO), Issue to Manufacturing Order 
(ISSUEMO), Quantity Adjustment (ADJQTY), Cost Adjustment (ADJCST), Scrap Adjustment 
(ADJSCRAP), Project/Account Transfer (TRNFPAO), PO Receipt (TRNFRCPT). It populates either the 
owning organization linked to the project or the material organization linked to the inventory abbreviation 
associated with the inventory transaction.  

 

Create Inventory Allocations (INPALLOC)  

The following are the changes to the lookup screen: 

 Manufacturing Order — Costpoint now narrows the search and displays only manufacturing 
orders (MOs) where the logged-in user ID is authorized for the planner’s organization ID. 
Costpoint will not display MOs without the planner’s organization ID.  

 Purchase Order — Costpoint now narrows the search and displays only POs where the logged-in 
user ID is authorized for the buyer’s organization ID. Costpoint will not display POs without the 
buyer’s organization ID.  

 Inventory Issues — Costpoint now narrows the search and displays only inventory issue records 
where the logged-in user ID is authorized for the To Organization. Costpoint will not display 
records with blank To Organization.  

 Inventory Transfer — Costpoint now narrows the search and displays only records where the 
logged-in user ID is authorized for the To Organization. Costpoint will not display records with 
blank To Organization.  

 Sales Order — Costpoint now narrows the search and displays only sales orders where the 
logged-in user ID is authorized for the sales order organization ID. Costpoint will not display 
records sales order organization IDs are left blank.  

 Costpoint will not create allocations to the transactions where the logged-in user is not authorized 
for, or where the reference organization IDs are left blank.  

View Purchase Order Status (POQSTAT)  

The following are the changes to this screen:  

 Find/Query — Costpoint now finds and filters existing records based on your logged-in user ID’s 
authorization for the buyer’s organization ID. In addition, Costpoint will not display records where 
buyer’s organization IDs are left blank.  

 Costpoint now validates your selected/entered entry against your logged-in user ID's rights to 
buyer’s organization and organization linked to the requisition.  

 Lookup (Purchase Order) — Costpoint now narrows the search and displays only purchase 
orders (PO) with buyer’s organizations that are authorized for the logged-in user ID. In addition, 
Costpoint will not display POs where buyer’s organizations are left blank. 

Note: You must run this utility before turning on organization security for a module. If you skip this 
process, query results will exclude sales orders with blank organization IDs.  
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Rename Process Flag 
The Flag DD250 Packing Slips as Printed was renamed to Flag DD250/WA250 Packing Slips as Printed. 

System Requirements 

This enhancement requires the following: 

 cp711_sys_044.zip  

 cp711_cmnlib_MMORGSECLIB_004.zip  

 PATCH3489  

 PATCH5122  

 PATCH7151  

Application JAR Requirements 

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

MM OE OER250PS Print DD250 
Packing Slips 

cp711_oer250ps_006.zip 

 

MMDLVRYSCHDLIB Library  
The MMDLVRYSCHDLIB library contains common business logic, which is shared by the following 
applications: 

 Manage Purchase Requisitions (PPMNTRQ1)  

 Manage Purchase Orders (POMMAIN)  

 Approve Pending Purchase Orders (POMSTAT)  

 Apply PO Info to Purchase Requisitions (PPMNTRQ2)  

 Create Blanket Purchase Order Releases (POMRELS)  

 Expedite Purchase Orders (POMEXPD)  

 Apply PO Info to Purchase Requisitions by Line (PPMRQLN)  

 View Purchase Order Status (POQSTAT)  

 View Item Purchasing Information (POQITEM)  

 View Purchase Order Change Orders (POQCHNG)  

 Approve Purchase Requisitions (PPMRQAPX)  

 Manage Purchase Order Vouchers (POMPOVCH)  

 Approve Purchase Requisition Lines (PPMRQAPL)  

 Assign Purchase Requisition to Buyers (PPMBUYAS)  
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 Assign Purchase Requisition Lines to Buyers (PPMBUYAL)  

 View Purchase Requisition Status (PPQRQSTS)  

 View Part Inventory (INQPINV)  

 Manage Detailed Part Schedule (MRMDTPT)  

 View Summary Part Availability (MRQSPA)  

 Manage Simple Purchase Requisitions (PPMQREQ)  

System Requirements  

This enhancement requires the following:  

 cp711_cmnlib_ MMDLVRYSCHDLIB _001.zip  

 cp711_cmnlib_PPMENTRQ_017.zip  

 cp711_sys_044.zip 

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

MM PP PPMRQLN Apply PO Info to 
Purchase 
Requisitions by 
Line 

cp711_ppmrqln_025.zip 

MM PO POMEXPD Expedite 
Purchase Orders 

cp711_pomexpd_011.zip 

MM PO POMMAIN Manage 
Purchase Orders 

cp711_pommain_039.zip 

MM PO POMRELS Create Blanket 
Purchase Order 
Releases 

cp711_pomrels_022.zip 

 

DVGMESUBLIB Library  
The DVGMESUBLIB library contains common business logic, which is shared by the following 
applications:  

 Manage Proposal BOM Cost Estimates-Indented (MEMPRPLI)  

 Manage Proposal BOM Cost Estimates-Summarized (MEMPRPLS)  

System Requirements  

This enhancement requires the following:  
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 cp711_cmnlib_ DVGMESUBLIB _001.zip  

 cp711_sys_044.zip  

Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

MM ME Manage Proposal 
BOM Cost 
Estimates-
Indented 

MEMPRPLI cp711_memprpli_007.zip 

MM ME Manage Proposal 
BOM Cost 
Estimates-
Summarized 

MEMPRPLS cp711_memprpls_004.zip 

 

OEQSTATLIB Library  
The OEQSTATLIB library contains common business logic, which is shared by the following applications:  

 Select Invoices Ready for Use/Acceptance (OEMRFU)  

 View Sales Analysis Information (OEQSALES)  

 View Sales Order Status Information (OEQSTAT)  

System Requirements  

This enhancement requires the following:  

 cp711_cmnlib_ OEQSTATLIB _001.zip  

 cp711_sys_044.zip  

PCMMOISSLIB Library  
The PCMMOISSLIB library contains common business logic, which is shared by the following 
applications:  

 Enter Manufacturing Order Issues (PCMMOISS)  

 Enter Manufacturing Order Issues (INMMOISS)  

System Requirements  

This enhancement requires the following:  

 cp711_cmnlib_ PCMMOISSLIB _001.zip  

 cp711_sys_044.zip  
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Application JAR Requirements  

The following table lists the Costpoint 7.1.1 screens affected by this update. It includes the required JAR 
version for each application, if applicable. 

Domain Module Application ID Application 
Name 

Application File 

MM PC PCMMOISS Enter 
Manufacturing 
Order Issues 

cp711_pcmmoiss_025.zip 

MM IN INMMOISS Enter 
Manufacturing 
Order Issues 

cp711_inmmoiss_001.zip 

 

Administration 

New Word Template Application and Add-In 
The Costpoint Word Template Add-in is available to download from Deltek Software Manager. Use the 
add-in to easily build Word report templates which are then used with the new Manage Word Templates 
(SYMWRPTM) application in Costpoint to print customized reports. 

System Requirements 

This enhancement requires the following: 

 PATCH7133 

 cp711_symwrptm_001.zip 

 cp711_sys_032.zip 

DeltekCostpointWordTemplateAddIn_Build01.exe 

Reports & Analytics 

Role-Based Dashboards: Limitation on the Number of Dashparts 
Displayed 
The number of dashparts that display on the Dashboard Reports tab depends on the number of 
dashparts you have open on the Parameters tab and your screen resolution. For example, if your screen 
resolution is lower than 1680 pixels, not all eight dashparts opened on the Parameters tab will be 
displayed on the Reports tab. 

As a workaround, you can do any of the following: 

 Toggle between the Parameters and Reports tabs to add (open) and remove (close) dashparts 
that you want to view.  
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 Drag the dashpart table windows up or down on the Parameters tab to rearrange the dashparts. 
Costpoint displays the dashparts on the Reports tab in the order that they appear on the 
Parameters tab, first to last. 

 Set your screen resolution to 1920 pixels, which is the recommended resolution to view all 
dashparts. Note, however, that if your screen does not support 1920 pixels, you will not be able to 
set that resolution. 

Costpoint Integration 
There are no changes to Costpoint Integration for this release. 
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Budgeting and Planning 

Planning 

Planning Domain Created 

 

Warning: This enhancement includes changes to security that will affect the ability of users to 
access certain applications. See “Security Changes Required for New Modules” below for related 
information. 

A Planning domain was added to Costpoint so that all the Budgeting & Planning applications can be 
housed in the same location. Previously, Budgeting & Planning applications were contained within three 
separate Costpoint domains (Accounting, Projects, and Administration).   

A Proposal Budgeting module was also added, which contains certain applications that were previously 
located within Project Budgeting. Additionally, planning-specific applications were relocated to a new 
Resource Planning module. 

 
The new domain and restructured menu help accommodate the many users who only need access to the 
planning capabilities of Budgeting & Planning.  . 

Proposal Budgeting Module 

Proposal Budgeting is now a separate module.  

This module contains the Actions/Processing and the Reports/Inquiries applications. 
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New Resource Planning Module 

A new module called Resource Planning was also created. This module contains the Budget By 
Resource application. 
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Administration Module Changes 

Budgeting Administration module was changed to Administration and the File Management module was 
removed. File Management is now part of the Costpoint Administration Domain. 

   

Security Changes Required for New Modules 

The CP administrator needs to assign the Proposal Budgeting and Resource Planning modules to the 
User Groups affected otherwise they will have no access to the new modules until new security is added. 

To set User Groups, complete the following steps: 

1. Click Administration » Security » System Security » Manage User Groups. 

2. Select Assign Users to Group subtask 

3. Select Module Rights subtask 
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 Module Rights — Use this subtask to assign Read-Only, Full, or Deny rights in one or more 

Costpoint modules to a user group by company. 
 

For a complete listing of the new menu structure, see 
DeltekBudgetingandPlanning700MenuMapping70to61.pdf 

Requirements 

The enhancement requires   

cp711_bnp_common_011.zip 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » 
Application 
Group 

Application ID Application 
Name 

Application File 

Plannin
g 

Resource 
Planning  » 
Resource 
Planning 

BNP_BGMBPIR Budget by 
Resource 

cp711_bp_bnp_bgmbpir_006.
zip 

 

Plannin
g 

 

Proposal 
Budgeting » 
Actions 
Processing  

BNP_NBMNPI4 Project 
Proposals 
(NPI4) 

cp711_bp_bnp_nbmnpi4_007
.zip 

Budget Labor Hours by GLC or PLC 
Labor budgeting was enhanced to allow budgeting by labor category, either GLC (general labor category) 
or PLC (project labor category), without the need to specify a resource. 

This update was applied to the following applications within the Planning Domain: 

http://ashapt535vs:82/SYMGRP_Module_Rights_Subtask.html
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 Project Budgeting » Budget/EAC Processing » Project Budget/EACs  

 Proposal Budgeting » Actions/Processing » Project Proposals (NPI4)  

 Proposal Budgeting » Actions/Processing » Project Non-Backlog Budgets (NPI7)  

When budgeting labor in the Staff Hours, Subcontractor Hours, or Consultant Hours subtasks in any of 
the above applications, you can assign hours directly to a labor category by selecting either GLC or PLC 
from the ID Type drop-down list.  

 
The PLC column within these subtasks was renamed to GLC/PLC. The codes available for selection are 
determined by the ID Type selected. After you select the code, you can modify the Hr Rate field as 
needed. The amount in the Hr Rate field is the cost associated with the GLC/PLC. 

 
Note that if the Hr Rate field defaults to zero and you do not enter a rate, revenue will not be offset by 
labor costs. 

Prior to this enhancement, the cost (Hr Rate) of the resource (for example, employee, subcontractor, or 
consultant) was already established, so revenue was automatically offset by cost within the budget. 

To help you manage GLC and PLC rates, two new applications have also been added to Budgeting & 
Planning.  

Manage Cost Rates 

To establish PLC and GLC rates outside of the budgeting application, use the following screens: 

 Planning » Project Budgeting » Controls and Utilities » Manage Average Cost GLC Rates  

 Planning » Project Budgeting » Controls and Utilities » Manage Average Cost PLC Rates 

Note that these are existing Costpoint screens (Projects » Advanced Project Budget Controls) which 
were added to the Budgeting & Planning menu structure, so though technically not new, they are new 
within Budgeting & Planning. 
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These “new” screens are used to add or edit cost rates for an existing GLC or PLC. When that GLC or 
PLC is selected in a budgeting application, the rate automatically populates the HR Rate field. However, 
since that field remains editable, the rate can still be modified from within the budgeting application.  

To learn more about these screens, see the following in the online Help: 

• Manage Average Cost GLC Rates 

• Manage Average Cost PLC Rates 

Project Labor Category Subtask Updates 

Other changes related to this feature were applied to the Project Labor Categories subtask, including the 
following: 

 To improve usability, the subtask link now displays directly on the Project Budgets/EACs screen. 
It was previously located on the Revenue Setup/Ceilings subtask.   

 Column labels were updated as follows: 

Link to Accounting System PLC label was changed to Link to Project PLC. 

Accounting PLC was changed to Project PLC. 

Accounting PLC Description was changed Project PLC Description. 

Labor Report Updates 

Project Budgeting reports are currently in the process of being updated to include labor hours budgeted 
by GLC or PLC. For this current release, the Revenue Analysis (BPA17) report was updated. Additional 
reports will be updated in future releases.  

Requirements 

cp711_bnp_common_011.zip 

Administration 

Project Budget Security Applied to Project Budgets/EACs 
The Project Budgets/EACs screen was updated to reflect changes related to the new Project Security to 
be based on setting in Planning » Administration » Administration Controls » Configuration 
Settings (MAM10).  

If Project Security to be based on is selected as Project Budget Security, users will now have 
restricted access to the projects that display in Project Budgets/EACs application. 

To learn more about this new security setting, see 
“DeltekBudgetingandPlanning700ReleaseNotesProjectBudgetSecurityOptionConfigurationSettings.pdf” 
from the July 2018 release. 

Requirements 

The following table shows the required file for the screen affected by this update: 

http://ashapt496vs/cpweb/helpfiles/costpoint/BPMAGLC.html
http://ashapt496vs/cpweb/helpfiles/costpoint/BPMAPLC.html
https://dsm.deltek.com/DeltekSoftwareManagerAdministrator/
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Domain Module » Application 
Group 

Application ID Application 
Name 

Required File 

Planning Project Budgeting » 
Budget/EAC 
Processing 

BNP_BGMPB
IX 

Project 
Budgets/EAC
s 

cp711_bnp_common_011.zi
p 

Project Budget Security Enhanced 
A new Maintain Project Budget Security application was added that will enable Project Budget 
Accountants to separate Project Budget Creators and Project Budget Approvers similar to Org Budgeting. 
To access this new application, go to Planning » Administration » Administration Controls » Maintain 
Project Budget Security 

 
For more information screen fields, see the Maintain Project Budget Security online help topic. 

Configure Project Budget Security 

To use the Maintain Project Budget Secutiy application, you need to select Project Budget Security 
from the drop-down menu of the Project Security to be based on field of the Project tab of Planning » 
Administration » Administration Controls » Configuration Settings (MAM10).   

Note that this configuration setting was added in July 2018, and the default setting is Org ID. 

Switching this setting to Project Budget Security allows Project Managers to approve and create project 
budget. If security is based on Org ID, and for example, a Project manager has a Home Org of an 
Overhead type, he or she could not edit project budgets and associated resources that have a Direct type 
of Home Org, such as Engineering or Construction. 

Note that with the addition of the new Project Security to be based on configuration option, the Manage 
Additional Project Budget Approvers (MAP8) screen was made obsolete and has been removed. 
During installation, existing entries from Project Budget Approvers (MAP8) are migrated to Maintain 
Project Budget Security, where they are denoted by “MAP8” in the Source field. 

 

 

This release includes menu changes related to the creation of the Planning Domain. It is highly 
recommended that cp711_sys_044.zip and cp711_bnp_common_011.zip be installed to reflect 
all framework changes, icons, positioning and application updates.  

Refer to DeltekBudgetingandPlanning700ReleaseNotesNewPlanningDomain.pdf in DSM for 
more details. 
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Known Issue 

Online Help for the Maintain Project Budget Security screen is not yet available for locally installed help, 
but it is for hosted help. The issue will be fixed for local help installations in the next release. 

Requirements 

The enhancement requires   
cp711_bp_patch1304_001.zip 

cp711_bnp_common_011.zip 

Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » Application 
Group 

Application ID Applicatio
n Name 

Application File 

Planning Administration » 
Administration Controls 

BNP_BAMPBA Maintain 
Project 
Budget 
Security 

cp711_bp_bnp_bampba_001.
zip 

Vendor Employee Enhancements 
The Vendor Employee feature was further updated to include new configuration options as well as the 
ability to import budgets/EACs for Vendor Employees from Excel. 

Configuration Setting Updates 

The Planning » Administration » Administration Controls » Configuration Settings (MAM10) screen 
was updated as follows. 

Workforce Rule Enforced for Vendor Employees  

If Workforce Rule on the Project tab is set to Enforce, that setting will now also be applied to Vendor 
Employees. Prior to this enhancement it only enforced Employee Workforce. Note that the following 
screen text was added next to this field: “Includes Employees, Vendors and Vendor Employees.”  

 
New Display Option  
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An Include Vendor Employees in Vendor Lookups and Drop-Down lists check box was added to the 
Display tab. Select this check box to include Vendor Employees in drop-down lists for screen entry and 
reporting. 

 
Note that there is an existing setting for Employee Vendors (Include Employees Vendors in Vendor 
Lookups and Drop-Down ), which you should take care not to confuse with the new setting for Vendor 
Employees, who are employees of a subcontractor Vendor.  

Conversely, Employee vendors are regular employees who have been set up as Vendors in Accounting 
» Accounts Payable » Vendors » Manage Vendors so that they can submit Expense Reports that are 
processed through Accounts Payable. 

Import Vendor Employee Budget/EACs from Excel 
The Import Budget/EACs from Excel application was updated to include the ability to import budgets for 
Vendor Employees. 

To access this new option, go to Planning » Project Budgeting » Controls and Utilities » Import 
Budget/EACs from Excel, and click the Excel Template subtask. Follow screen instructions for 
downloading the updated template, which now includes Vendor Employee as an option in the ID Type 
drop-down list. 

 
Note: An Hourly Rate for Vendor Employees should be completed on the Excel Template. 

Requirements 

The enhancement requires   

cp711_bnp_common_011.zip 
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Application JAR Requirements 

The following table shows the required application JAR version for the screens affected by this update: 

Domain Module » 
Application 
Group 

Application ID Application 
Name 

Application File 

Planning Administration bnp_bammam10 Configuration 
Settings 
(MAM10) 

cp711_bp_bnp_bammam10_010.zip 

 

 



Time and Expense 

Cumulative Release Notes for August 2018 48 

 

Time and Expense 
No enhancements were deployed for Time & Expense in August.  

 



 

 

About Deltek 
Better software means better projects. Deltek is the leading global provider of enterprise software and 
information solutions for project-based businesses. More than 23,000 organizations and millions of users 
in over 80 countries around the world rely on Deltek for superior levels of project intelligence, 
management and collaboration. Our industry-focused expertise powers project success by helping firms 
achieve performance that maximizes productivity and revenue. www.deltek.com 

http://www.deltek.com/
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